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1 Device basics

This chapter contains information about the following topics:

● Conventions used in this guide

● Product walkaround

● Turn the device on and off

● Use the control panel

● Supported paper

● Load trays

● Load special types of paper

WARNING! To avoid injury, do not touch moving parts. Do not reach into the device except to clear
jams, to replace ink cartridges, or to add or remove paper.
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Conventions used in this guide
Throughout this guide, several tips, notes, cautions, and warnings alert you about important information.

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging the
device.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal injury,
catastrophic loss of data, or extensive damage to the device.
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Product walkaround
Before using the device, familiarize yourself with its major components.

Front view

1 On/off button

2 Document feeder

3 Control panel

4 Front door

5 Tray 1 (manual feed; holds 80 sheets of standard paper)

6 Tray 5 (optional high-capacity tray; holds 4,000 sheets of standard paper)

7 Tray 4 (holds 500 sheets of standard paper)

8 Tray 3 (holds 500 sheets of standard paper)

9 Tray 2 (holds 500 sheets of standard paper)

10 Ink cartridge door

11 Optional finisher
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Back view (right side)

1 Master power switch

2 Power connection

WARNING! Do not use the master power switch or unplug the device unless you have already turned
the device off by using the on/off button on the control panel. If you use the master power switch to turn
off the device, wait for the amber LED to turn dark before you turn the switch on again.

Back view (left side)
The following figure shows the interface ports for the device.
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1 Boot Codes LCD monitor (for service use only)

2 Host USB (for connecting an accessory to the device)

3 Fax (RJ-11) (covered with label)

4 Embedded LAN (RJ-45) (no telecommunication connections)

5 CAN Interface (Finisher)

6 Engine Interface (PCI Express)

7 Scanner Interface

8 EIO Slot

9 FIH (Foreign Interface Harness)

10 Device USB (for connecting the device to a computer)

11 Status LEDs for (service use only)

12 Engine Power Control (Serial)

Single output bin

1 Single output bin
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Optional finishers
By default, when an optional finisher is installed, all copy jobs are sent to Output Bin 1, print jobs are
sent to Output Bin 2, and fax jobs are sent to Output Bin 3. The system administrator can change these
default settings.

Optional HP 4-Bin Job Separator

1 Output Bin 1 (Copy jobs)

2 Output Bin 2 (Print jobs)

3 Output Bin 3 (Fax jobs)

4 Output Bin 4
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Optional HP Multifunction Finisher

1 Output Bin 1 (Copy jobs)

2 Output Bin 2 (Print jobs)

3 Output Bin 3 (Fax jobs)

4 Output Bin 4

5 Output Bin 5 (all stapled jobs are delivered to Output Bin 5)

6 Stapler 2

7 Stapler 1
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Turn the device on and off
To turn the device on and off, press the on/off button on the device control panel.

WARNING! Do not use the master power switch or unplug the device unless you have already turned
the device off by using the on/off button on the control panel.
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Use the control panel
The control panel has a full-color VGA touchscreen that provides easy access to all device functions.
Use the buttons and numeric keypad to control jobs and the device status. The LED lights indicate overall
device status.

Control-panel layout

1 On/off button Turn the device on and off.

2 Touchscreen Select and use all device features.

3 Numeric keypad Specify the quantity for copies and other numeric information.

4 Interrupt button Pause the device so you can insert a new job into the queue for immediate
printing.

5 Sleep button Put the device into a low-power, Sleep mode to save energy.

If the device is already in Sleep mode, the light next to the button is lit amber.
Press Sleep to return to the ready mode.

6 Reset button Restore all the device settings to the default values, and return to the Home
screen. Press this button to sign out if you are signed in. This button will also
resume the device if it is paused. 

7 Stop button Halt the current job. The job status screen opens. If it was processing a scan
job, the job is immediately canceled. Touch OK to continue.

8 Start button Begin copying, scanning, printing a stored job, or resume printing a job that has
been interrupted.

9 Clear button Clear the active number or text field, or return it to the default value.

10 Attention light Indicates that the device has a condition that requires intervention. Examples
include an empty paper tray or an error message on the touchscreen.

11 Data light Indicates that the device is receiving data.

12 Ready light Indicates that the device is ready to begin processing any job.

13 Brightness-adjustment dial Controls the background lighting of the touchscreen.
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Home screen
The Home screen provides access to the device features, and it indicates the current status of the
device.

NOTE: Depending on how the system administrator has configured the device, the features that
appear on the Home screen can vary. To use some features, you might need to sign in.

HP CM8060 Color MFP with Edgeline Technology

1 3 42

5

678

1 Device status line Provides information about the overall device status. Various buttons appear in
this area, depending on the current status. For a description of the buttons that
can appear on the touchscreen, see Buttons on the touchscreen on page 12.

2 Features Depending on how the system administrator has configured the device, the
features that appear in this area can include any of the following items:

● Copy

● Fax

● E-mail

● Network Folder

● Job Storage

● Job Status

● Supplies Status

● Administration

● Service

You might need to scroll to see all the features.

3 Help button Open the built-in Help system. You can search for information by using the Help
menu, or you can search by keyword. See Control-panel Help system
on page 12.

4 Copy count Indicates the number of copies that the device is set to make. To change the
copy count, touch the box to open a virtual keypad, or use the numeric keypad
on the control panel.

5 Scroll bar Touch the up or down arrows on the scroll bar to see the complete list of available
features.
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6 Sign In or Sign Out You might be required to sign in to use features for which the system
administrator has controlled access. These features have a lock symbol ( )
next to them. Depending on your permissions, if you have signed in, you still
might not have access to some features.

NOTE: The lock symbol appears after you have signed in. The device
administrator can access all of the device features, except the Service menu.

Touch Sign In to open a virtual keyboard so you can type your user name and
password, or type your access code. After you sign in, the name of this button
changes to Sign Out.

7 Network Address Find information to connect the device to the network or to install a printer
driver.

8 Date and time The current date and time appear here. The system administrator can select the
format that the device uses to show the date and time, for example: 12-hour
format or 24-hour format.
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Buttons on the touchscreen
Various buttons can appear on the touchscreen.

Home button. Touch this button to go to the Home screen from any other screen.

Start button. Touch this button to begin the action for the feature that you are using. 

NOTE: The name of this button changes for each feature. For example, in the Copy feature, the button
is named Start Copy.

Information button. This button appears when two or more settings are in conflict. Touch the button to
learn how to resolve the conflict.

Error button. This button appears whenever the device has an error that requires attention before it can
continue. Touch this button to see a message that describes the error. The message also has instructions
for solving the problem.

Warning button. This button appears when the device has a problem but can continue functioning. Touch
the warning button to see a message that describes the problem. The message also has instructions for
solving the problem.

Help button. Touch this button to open the built-in online Help system. For more information, see Control-
panel Help system on page 12.

Control-panel Help system
The device has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help button ( ) in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu. You can also search for
information by using a keyword. Touch Index and then type a keyword.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the device alerts you of an error or warning, touch the error ( ) or warning ( ) button to open a
message that describes the problem. The message also contains instructions to help solve the problem.

12 Chapter 1   Device basics ENWW



Supported paper
The device produces high-quality documents in the fastest possible time when you follow these
guidelines:

● The device is designed to work with a broad range of plain papers for general-office use. For
optimum performance, use paper from the list of recommended papers.

● Always configure the tray for the correct paper type, and select the correct type from the printer
driver.

Before using any paper, verify that it is of good quality and is free of cuts, nicks, tears, spots, loose
particles, dust, wrinkles, curls, or bent corners.

Recommended paper
The paper types that are listed in this section have been tested and are known to work with the device.
These paper types are divided into three categories:

● HP-brand tested and qualified papers. Use these paper types for the best results. Some of these
papers have been specially formulated for use with this device.

● HP-brand papers that are not specifically optimized for this device. These papers work with the
device, but the results might be of lesser quality than when using the tested and qualified papers.

● Certain non-HP brand papers. These paper types produce satisfactory print quality.

NOTE: Because HP cannot control paper formulations for these non-HP papers, future results
might not match past testing.

HP-brand paper is available at www.hpshopping.com or from local office-supplies retailers.

CAUTION: Using paper or other print media that does not meet HP specifications might cause
problems that require repair. This repair is not covered by the HP warranty or service agreements.

The device does not support envelopes or transparencies.

Table 1-1  Supported brands of paper for this device

HP-brand tested and qualified papers HP-brand supported papers (not
optimized for this device)

Tested non-HP papers

Plain paper

HP Office

HP Multipurpose

HP Printing Paper

HP Copy Paper

HP Office Paper LG

Brochure paper

HP Edgeline Glossy, 180 g/m2

HP Premium Presentation Matte

HP Brochure and Flyer Paper Matte

HP All-In-One Paper

HP Everyday Copy & Print Paper

HP LaserJet Paper

HP Color Laser Paper

HP Advanced Paper

HP Office Recycled Paper

HP Inkjet Paper

HP Color Inkjet Paper

HP Bright White

HP Premium Choice

North America

Boise X9

Domtar Copy Paper

GP Spectrum DP Copy

GP Copy Paper

IP HammerMill Fore MP

IP Great White Copy Paper

Wausau Exact Multipurpose

Weyerhauser Husky Xerocopy

Xerox 4200
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HP-brand tested and qualified papers HP-brand supported papers (not
optimized for this device)

Tested non-HP papers

Speciality paper

HP Office Paper - Prepunched

HP Labels

Outside North America

Clairealfa White

IP Rey Office

IP Duo Colourcopy

Mondi IQ Economy

M-Real Data Copy

Portucel Navigator Universal

Stora-Enso Multicopy

UPM Office copy/print

Xerox Premier

Reflex Pure White

Guidelines for using specialty papers
Table 1-2  Guidelines for specialty papers

Paper type Guidelines

Labels Load labels only in Tray 1. Load labels with the front side facing down.

Labels should lie flat with no more than 13 mm (0.5 inch) of curl in any direction.

Use only full sheets of labels. If sheets have spaces between the labels, labels can peel off,
which can cause jams that are difficult to remove.

Do not use labels that have wrinkles, bubbles, or that are peeling off the backing paper.

Cardstock Load heavier cardstock, up to 220 g/m² (80 lb cover) cardstock, only in Tray 1.

Cardstock up to 180 g/m² (67 lb cover) can be loaded in any tray.

Cardstock should have a smoothness rating of 100 to 180 Sheffield.

Cardstock should lie flat with no more than 13 mm (0.5 inch) of curl in any direction.

Do not use cardstock that is wrinkled, nicked, or otherwise damaged.

HP Edgeline Glossy Load HP Edgeline Glossy paper only in Tray 1.

Fan the stack of paper before placing the sheets in the tray. This helps prevent the sheets from
sticking together.

Transparencies The device does not support transparencies. Do not try to print on them.

Envelopes The device does not support envelopes. Do not try to print on them.

Recommended paper for specific types of documents
The device supports many types of paper. Use the information in the following table to select a type of
paper for specific types of documents.

Table 1-1  Supported brands of paper for this device (continued)
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Table 1-3  Recommended papers for document types

Document type Recommended paper Type of finish

General office copying and
printing

HP Office

HP Office LG (long grain)

Matte

Color document HP Bright White Matte

Photographs, images, business
plans, brochures, sales flyers,
catalogs, covers, postcards, signs,
maps, restaurant menus

HP Edgeline Glossy, 180 g/m2 Glossy

Correspondence HP Office

HP Office LG (long grain)

Matte

Letterhead HP Bright White Matte

Report HP Premium Presentation Matte

HP Brochure and Flyer Paper Matte

Coated Matte

Proposal HP Bright White Matte

Newsletter HP Bright White Matte

Training manual HP Office

HP Office LG (long grain)

HP Office (prepunched)

Matte

User manual HP Office

HP Office LG (long grain)

HP Office (prepunched)

Matte
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Supported paper types for each tray
When you select a paper type, you are instructing the device to use a group of predefined settings to
create the best possible print quality for that type of paper.

CAUTION: Selecting a paper type that does not match the type of paper that is loaded in the tray can
damage the device.

Table 1-4  Supported paper types for each tray

Paper type that is listed in the
printer driver or on the control
panel

Description Tray 1 Trays 2, 3, and 4 Tray 5

Plain Plain, uncoated paper that is less than
150 g/m2 (40 lb bond)

X X X

HP Matte Premium 120g Use only for HP Premium Presentation
Matte Paper, 120 g/m2

X   

HP Matte Brochure 180g Use only for HP Brochure and Flyer
Paper Matte, 180 g/m2

X   

HP Matte Cover 200g Use only for this HP-brand paper. X   

HP Glossy Edgeline 180g Use only for HP Glossy for Edgeline
Paper, 180 g/m2

X   

Cardstock Plain, uncoated paper that is from 160
to 220 g/m2 (60 to 80 lb cover)

X   

Cardstock Plain, uncoated paper that is from 160
to 180 g/m2 (60 to 67 lb cover)

X X X

Matte Plain, uncoated paper.

A3 or 11x17 inch paper must be
long-grain.

X X X

Matte Brochure Plain, uncoated paper.

A3 or 11x17 inch paper must be
long-grain.

X X X

Matte Cover Plain, uncoated paper that is from 160
to 220 g/m2 (60 to 80 lb cover)

X   

Labels Uncoated, non-glossy labels X   

Letterhead Fine, uncoated paper that is less than
150 g/m2 (40 lb bond)

X X X

Preprinted Plain, uncoated paper that is less than
150 g/m2 (40 lb bond)

X X X

Prepunched Letter (3-hole) or A4 (2- or 4-hole) size
paper that is less than 150 g/m2 (40 lb
bond)

X X X

Colored Plain, uncoated paper that is less than
150 g/m2 (40 lb bond)

X X X
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Paper type that is listed in the
printer driver or on the control
panel

Description Tray 1 Trays 2, 3, and 4 Tray 5

Bond Fine, uncoated paper that is less than
150 g/m2 (40 lb bond)

X X X

Recycled Plain, uncoated paper that is less than
150 g/m2 (40 lb bond)

X X X

Supported paper sizes for each tray
Standard paper sizes are marked in the trays. To use a custom paper size, use Tray 1.

Table 1-5  Supported paper sizes for each tray

Size Dimensions Tray 1 Trays 2, 3, and 4 Tray 5

Letter 216 x 280 mm

8.5 x 11 inches

X X X

Legal 216 x 356 mm

8.5 x 14 inches

X X  

Executive 184 x 267 mm

7.25 x 10.5 inches

X X  

Statement 140 x 216 mm

5.5 x 8.5 inches

X X  

8.5 x 13 216 x 330 mm

8.5 x 13 inches

X X  

11 x 17 280 x 432 mm

11 x 17 inches

X X  

12 x 18 305 x 457 mm

12 x 18 inches

X   

4 x 6 102 x 152 mm

4 x 6 inches

X   

5 x 7 127 x 178 mm

5 x 7 inches

X   

5 x 8 127 x 203 mm

5 x 8 inches

X   

A3 297 x 420 mm

11.69 x 16.54 inches

X X  

A4 210 x 297 mm

8.27 x 11.69 inches

X X X

Table 1-4  Supported paper types for each tray (continued)
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Size Dimensions Tray 1 Trays 2, 3, and 4 Tray 5

A5 148 x 210 mm

5.83 x 8.27 inches

X X  

RA3 305 x 430 mm

12.01 x 16.93 inches

X   

RA4 215 x 305 mm

8.46 x 12.01 inches

X   

SRA4 225 x 320 mm

8.86 x 12.6 inches

X   

B4 (JIS) 257 x 364 mm

10.12 x 14.33 inches

X X  

B5 (JIS) 182 x 257 mm

7.17 x 10.12 inches

X X  

B6 (JIS) 128 x 182 mm

5.04 x 7.17 inches

X   

8K 273 x 394 mm

10.75 x 15.5 inches

X   

16K 197 x 273 mm

7.75 x 10.75 inches

X   

Custom Minimum: 102 x 152 mm
(4 x 6 inches)

Maximum: 320 x 457 mm
(12.6 x 18 inches)

X   

Table 1-5  Supported paper sizes for each tray (continued)
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Capacity of each tray and bin
To avoid jams and print-quality problems, load the trays with the correct amount of paper. Load complete
reams at one time.

Remove paper from the output bins when they are full.

Table 1-6  Capacity of each tray and bin

Tray or bin Capacity Weight

Scanner glass One sheet of paper, up to 305 x 445 mm
(12 x 17.1 inches)

Maximum scanning area is 297 x 433 mm
(11.7 x 17.0 inches)

Any weight of paper

Objects, such as books, up to 50 mm
(1.97 inches) high

Document feeder 100 sheets of paper, 75 g/m2 (20 lb bond) 60 to 135 g/m2 (16 to 36 lb bond)

Tray 1 80 sheets of paper, 75 g/m2 (20 lb bond) 60 to 220 g/m2 (16 to 58 lb bond)

Trays 2, 3, and 4 500 sheets of paper, 75 g/m2 (20 lb bond) 60 to 180 g/m2 (16 to 48 lb bond)

Tray 5 4,000 sheets of paper, 75 g/m2 (20 lb bond)

Letter or A4 size only

60 to 180 g/m2 (16 to 48 lb bond)

Single output bin 250 sheets of paper, 75 g/m2 (20 lb bond) 60 to 220 g/m2 (16 to 58 lb bond)

HP Multifunction Finisher Output Bins 1 and 2: 400 sheets

Output Bins 3 and 4: 200 sheets

Output Bin 5: 2,500 sheets

60 to 220 g/m2 (16 to 58 lb bond)

HP 4-Bin Job Separator Output Bins 1 and 2: 400 sheets

Output Bins 3 and 4: 200 sheets

60 to 220 g/m2 (16 to 58 lb bond)

Supported paper sizes for each bin
Table 1-7  Supported paper sizes for each bin

Bin Length Width

Output Bins 1, 2, 3, and 4 457 to 152 mm (18 to 6 inches) 320 to 102 mm (12.6 to 4 inches)

Output Bin 5

(HP Multifunction Finisher only)

432 to 230 mm (17 to 9.1 inches) 297 to 182 mm (11.7 to 7.2 inches)
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Load trays
Labels on each tray indicate the correct way to load paper. Each time you load paper into a tray, the
device prompts you to configure the tray for the paper size and type. Always set the paper size and type
to get the best performance from the device.

Load Tray 1 (manual feed tray)
Load standard or custom-sized paper into this tray. It holds up to 80 sheets of 75 g/m2 (20 lb bond)
paper. Also use this tray for heavier paper, such as cardstock, HP Edgeline Glossy, or brochure papers.

1. Slide the tray support up, pull it out, and then pull out the extension.

2. Move the guide outward.

3. Load the paper. Always load the paper with the short edge first.
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● Load letterhead or preprinted paper with the printed side face-down and the top edge to the
right.

NOTE: For duplex printing, load letterhead or preprinted paper with the printed side facing-
up and the top edge feeding first.

● Load prepunched paper with the side that has holes toward the front of the device.

● Load labels with the front side facing down.

● When loading HP Edgeline Glossy paper, fan the paper stack to separate the sheets before
placing them in the tray. This helps prevent the sheets from sticking together.

4. Adjust the guide so that it touches the paper.

5. Configure the tray for the type and size of paper.

a. From the Home screen, touch Supplies Status.

b. Touch the Trays tab.

c. If the size and type that are listed for the tray are not correct, touch the name of the tray, and
then touch Modify.

d. Select the correct paper size and type, and then touch OK.

-or-
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If you are loading a custom paper size, touch Custom. Type the dimensions of the paper, and
then touch OK to return to the Modify Tray screen.

e. Touch OK to save the settings.

Load Trays 2, 3, and 4
Trays 2, 3, and 4 hold many standard sizes and types of paper. Each tray holds up to 500 sheets of
75 g/m2 (20 lb bond) paper.

1. Open Tray 2, 3, or 4.

2. Load the paper, whole reams at a time. Always place the long edge along the front side of the tray.

● Load letterhead or preprinted paper with the printed side face-up and the top edge to the left.

NOTE: For duplex printing, load letterhead or preprinted paper with the printed side face-
down and the top edge to the right.

● Load prepunched paper with the edge that has the holes along the front side of the tray.

3. Adjust both guides so that they click into the position that is marked for the paper size.
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4. Slide the tray into the device.

5. Configure the tray for the type of paper by responding to the pop-up message that appears on the
touchscreen when you close the tray. Or, follow these steps:

a. From the Home screen, touch Supplies Status.

b. Touch the Trays tab.

c. If the type that is listed for the tray is not correct, touch the name of the tray, and then touch
Modify.

d. Select the correct paper type, and then touch OK.
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Load Tray 5
This tray is preconfigured to hold up to 4,000 sheets (8 reams) of either Letter-size or A4-size paper.
You cannot change this size setting.

1. Open the Tray 5 top door, and load the paper. Load whole reams at a time. The tray lowers itself
as you load more paper.

● Load letterhead or preprinted paper with the printed side face-down and the top edge to the
right.

NOTE: For duplex printing, load letterhead or preprinted paper with the printed side facing-
up and the top edge feeding first.

● Load prepunched paper with the side that has holes toward the front of the device.

2. Configure the tray for the type of paper by responding to the pop-up message that appears on the
touchscreen when you close the tray. Or, follow these steps:

a. From the Home screen, touch Supplies Status.

b. Touch the Trays tab.

c. If the paper type that is listed for the tray is not correct, touch the name of the tray, and then
touch Modify.

d. Select the correct paper type, and then touch OK.
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Load special types of paper
The following table provides guidelines for loading special types of paper. Use the correct paper-type
setting in the printer driver to obtain the best print quality.

NOTE: In the Windows printer driver, adjust the paper type on the Paper tab in the Type is drop-down
list.

In the Macintosh printer driver, adjust the paper type on the Finishing tab of the Finishing pop-up
menu. Select the Media Type drop-down list.

Table 1-8  Load special paper

Paper type Tray 1 paper orientation Trays 2–4 paper orientation Tray 5 paper orientation

Labels Front side facing down. Use only Tray 1 for printing on
labels.

Use only Tray 1 for printing on
labels.

Letterhead or Preprinted Front side facing down and
the top edge to the right.

Front side facing up and the
top edge toward the left.

Front side facing down and
the top edge to the right.

Prepunched Edge that has the holes
toward the front of the device.

Edge that has the holes
toward the front of the device.

Edge that has the holes
toward the front of the device.
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2 Use the device

This chapter contains information about the following topics:

● Copy

● Fax

● Send to e-mail

● Send to a network folder

● Job Storage

● Check job status and use the job queue

● Print from a Windows computer

● Print from a Macintosh computer

ENWW 27



Copy
You can scan original documents by using the document feeder or the scanner glass. The device has
several options available for customizing copied output.

Copy from the document feeder
The document feeder holds a maximum of 100 sheets of paper.

1. Place the original document face-up in the document feeder, with the top edge of the document
toward the rear of the document feeder or feeding first into the input slot. For two-sided originals,
place the first side of the original face-up.

NOTE:  The document feeder beeps and illuminates a green light when an original is properly
loaded.

2. Adjust the paper guides so that they are touching the original document.

NOTE: Depending on how the system administrator has configured the device, you might need to sign
in.

NOTE: For the fastest performance when using Letter or A4-size paper, place the short edge of the
document toward the rear of the document feeder.

To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy settings
on page 31.

NOTE: You can use either the hard Start button on the control panel or the Start Copy button on the
touchscreen.

Retrieve the original document from the output bin that is under the document feeder input-tray. Retrieve
the copies from the output bin that is on the left side of the device.
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Copy mixed-size originals
You can copy original documents that are printed on different sizes of paper as long as the sheets of
paper have one common dimension, and that dimension is not greater than 297 mm (11.7 inches). For
example, you could combine Letter and Legal sizes, or you could combine A4 and A5 sizes.

1. Arrange the sheets in the original document so they all have the same width.

2. Place the sheets face-up into the document feeder, and adjust the paper-width guides against the
document.

3. From the Home screen, touch Copy.

4. Touch More Options.

5. Touch Original Size.

6. Select Mixed Sizes (of same width), and then touch OK.

7. Touch Start Copy.

Copy from the glass
1. Place the original document face-down on the glass.

2. Align the corner of the original with the upper-left corner of the glass.

To use the default copy options, use the numeric keypad on the control panel to select the number of
copies, and press Start.

To use customized settings, touch Copy. Specify the settings, and then press Start. For more information
about using customized settings, see Adjust the copy settings on page 31.

NOTE: You can use either the hard Start button on the control panel or the Start Copy button on the
touchscreen.

In most cases, the device automatically detects the size of the original document on the glass. If the
original is a nonstandard size, or if you want to copy only part of it, use the Original Size feature to turn
off automatic size detection, and then specify the area to copy:

1. From the Home screen, touch Copy.

2. Touch More Options

3. Touch Original Size
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4. Select the size you wish to scan, and then touch OK. This turns off automatic size detection.

5. Touch Start Copy
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Adjust the copy settings
The device offers several features so you can optimize copied output. These features are all available
on the Copy screen.

The Copy screen consists of several pages. From the first page, touch More Options to go to the next
page. Then touch the up or down arrow buttons to scroll to other pages.

For details about how to use an option, touch the option, and then touch the help ( ) button in the upper-
right corner of the screen. The following table provides an overview of the copy options.

NOTE: Depending on how the system administrator has configured the device, some of these options
might not appear. The options in the table are listed in the order in which they can appear.

Table 2-1  Options for copy jobs

Option name Description

Sides Use this feature to indicate whether the original document is printed on one or both sides, and
whether the copies should be printed on one or both sides.

Color/Black Use this feature to select whether copies are printed in black & white or in color. Select Auto
detect to automatically detect whether each page of the original is in black & white or color, and
produce copies that are the same.

If you select Color or Auto detect, you can also select the Color Quality. Choose either General
Office or Professional. For some paper types, the color quality can only be set to
Professional.

Reduce/Enlarge Use this feature to reduce or enlarge the copied image. Touch the box below Scaling: to specify
a custom percentage. To reduce the image, select a value smaller than 100%. To enlarge the
image, select a value larger than 100%.

Paper Selection Use this feature to select the tray that holds the size and type of paper that you want to use.

Image Adjustment Use this feature to improve the overall quality of the copy. For example, you can adjust the
Darkness, Sharpness, and Contrast, and you can use the Background Cleanup setting to
remove faint images from the background or to remove a light background color.

Content Orientation Use this feature to specify the way the content of the original page is placed on the page: portrait
or landscape.

If you are copying a document that is printed on both sides, you can also specify the orientation
of the second side.

Output Bin Use this feature to select an output bin for the copies. If the optional HP Multifunction Finisher
is attached, stapled copies are always delivered to Output Bin 5. If a finisher is not installed,
the Output Bin option does not appear.

Staple/Collate Use this feature to collate copies in the output bin. If the optional HP Multifunction Finisher is
attached, this feature includes options for stapling.

Optimize Text/Picture Use this feature to optimize the output for a particular type of content. You can optimize the
output for text, printed pictures, photos, or a mixture.

Pages per Sheet Use this feature to copy multiple pages onto one sheet of paper.

Original Size Use this feature to describe the page size of the original document.

Watermark Use this feature to print semi-transparent text diagonally across the center of each page. You
can specify the color, text, and type-style to use, and you can adjust the transparency level.

Color Adjustment Use this feature to adjust the saturation and temperature settings to change the overall
appearance of color copies.
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Option name Description

Color Balance Use this feature to adjust colors individually to change the color balance in the copies. For
example, increasing the amount of cyan makes copies more blue and less red.

One/Two Color Use this feature to convert all the colors in a document to shades of a single color, or shades
of a single color plus black. For example, you could convert all colors to varying shades of blue.

Overlays Use this feature to print a semi-transparent image on each page. Overlays are similar to
watermarks, but overlays can consist of any image, such as a company logo.

Chapter Pages Use this feature to copy documents that have chapters. You can specify that the chapters
always begin on either the left or right page. If necessary, the device inserts blank images so
the first page of each chapter is on the correct side.

Stamp Page Number Use this feature to print page numbers on copies. You can control the numbering style and the
position.

Stamp Date/Time Use this feature to print the date and time on copies. You can control the numbering style and
the position of the information.

Stamp Text Use this feature to print a predefined text message on the copies or print a message that you
specify. A text stamp is similar to a watermark, but you can control the position on the page
and the angle.

Stamp Set Number Use this feature to print the set number on copies. For example, if you are making five copies
of a document, each page in the first set of copies is stamped with the same number. You can
select from several numbering formats, and you can specify the starting set number.

Edge-To-Edge If the original document is printed close to the edges, use this feature to ensure that the
maximum amount of content is copied. However, shadows might appear along the edges.

Job Build Use this feature to combine several sets of original documents into one copy job. Also use this
feature to copy an original document that has more pages than the document feeder can
accommodate at one time.

Auto Layout Use this feature when copying from the flatbed glass. Place the original document anywhere
on the flatbed glass. The device senses the edges of the document and centers the image on
the copy.

Auto Crop Use this feature to remove dark areas from the background when you copy with the flatbed
cover open. The device senses the edge of the object on the flatbed and removes the black
area from around the image.

Image Justify Use this feature to move the image to an edge, a corner, or the center of the page.

Image Shift Use this feature to shift the image on the page. This feature is similar to Image Justify, but it
moves the image by a particular measurement.

Image Repeat Use this feature to copy the same image multiple times on a single sheet of paper. To use this
feature, place the original on the flatbed glass, and leave the cover open.

Erase Edges Use this feature to remove any dark lines that appear at the edges of copies.

Erase Gutter Use this feature to remove the shadows that appear in the center of copies when you copy an
open book or when you copy two pages next to each other.

Negative Image Use this feature to reverse all the colors in a document. This feature changes red to cyan, blue
to yellow, green to magenta, and white to black.

Table 2-1  Options for copy jobs (continued)
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Use the job-build feature
Use the Job Build option to divide a complex job into smaller segments. This is useful when you are
scanning an original document that has more pages than the document feeder can hold or when you
want to combine pages that have different sizes into one job. You can use either the glass or the
document feeder to scan the original documents.

NOTE: The Job Build option is available for the Copy, E-mail, and Network Folder features.

1. Place the first segment of the job into the document feeder or onto the scanner glass.

NOTE: If you are scanning on the glass, each page is a separate segment.

2. Touch Copy, E-mail, or Network Folder, and then set the options that you want to use.

3. Touch Job Build and then select Job Build on. Touch OK.

4. Press Start to scan the first segment.

5. The device prompts you to load the next segment.

● If you want to apply different options to this segment or modify settings that apply to the whole
job, touch Options.

● If you have more segments to scan, touch Scan.

● If you have finished scanning all the segments, touch Finish.

● If you need to start over, touch Cancel Job.

6. When you select Finish, your job will begin processing.
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Fax
If an optional fax accessory is installed in the device and it is connected to an analog phone line, you
can use the device to send and receive faxes.

NOTE: If the system administrator has set up a LAN fax service or an Internet fax service, you can
use the device to send faxes, but not to receive faxes.

Configure the fax options for each job
The device offers several features so you can optimize each fax. These features are all available on the
Fax screen.

The Fax screen consists of two pages. From the first page, touch More Options to go to the next page.

For details about how to use an option, touch the option, and then touch the Help ( ) button in the
upper-right corner of the screen. The following table provides an overview of the fax options.

Depending on how the system administrator has configured the device, some of these options might
not appear. The options in the table are listed in the order in which they can appear.

Table 2-2  Options for fax jobs

Option name Description

Resolution Use this feature to set the resolution for outgoing faxes. Higher resolution images have more
dots per inch (dpi), so they show more detail. Lower resolution images have fewer dots per inch
and show less detail, but the file size is smaller.

Original Sides Use this feature to describe the layout for each side of the original document.

Notification Use this feature to receive notification about the status of an outgoing fax.

Content Orientation Use this feature to specify the way the content of the original document is placed on the page:
portrait or landscape.

Original Size Use this feature to describe the page size of the original document.

Image Adjustment Use this feature to improve the overall quality of the file. For example, you can adjust the
darkness, sharpness, and contrast, and you can use the Background Cleanup setting to remove
faint images from the background or to remove a light background color.

Optimize Text/Picture Use this feature to optimize the fax for a particular type of content. You can optimize for text or
printed pictures, or you can manually adjust the setting.
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Send faxes
1. Place the original document face-down on the glass or face-up in the document feeder.

2. From the Home screen, touch Fax to open the fax feature.

3. You can send a fax to a single recipient or to multiple recipients.

Specify the fax numbers by using one or both of these methods:

Type the fax number manually From the Fax screen, touch the box below Fax Number: to open the virtual
keypad. Type the fax number.

Touch Pause to indicate a required pause.

To delete a character, touch the backspace button ( ).

Use a speed dial From the Fax screen, select the speed-dial code from the list or touch the box
below Speed Dial Code: and type the speed-dial code.

To search for a speed dial, touch the search button ( ).

4. Touch OK to return to the main fax screen. To transfer the number into the fax recipients list, touch
the down arrow button ( ).

5. Touch More Options to see other fax options. For more information about using customized
settings, see Configure the fax options for each job on page 34.

6. After all the options are set, touch Send Fax ( ) to scan the document and send the fax.

7. To verify if the fax was sent successfully, open the Home screen and touch Job Status. Touch the
Job Log tab, and look for the fax in the list of completed jobs.

Receive faxes
The device can receive incoming faxes if an analog fax accessory is installed. If this accessory is not
installed, you can use a LAN fax service or Internet fax service to send faxes, but the device cannot
receive faxes.

The device places incoming faxes into the active job queue. If no other jobs are in the queue, the device
prints the fax immediately. If other jobs are in the queue, the device prints the fax after the jobs that are
ahead of it in the queue. If you want to print the fax sooner, you can promote it in the job queue.

NOTE: If the system administrator has set up a schedule for printing faxes, it is possible that all faxes
are stored on the device and then printed at a later time.

Promote a fax in the job queue

1. From the Home screen, touch Job Status.

2. On the Active tab, open the drop-down list named Select Job Type, and select Copy, Print, Incoming
Fax Jobs.

3. From the list of jobs, select the job, and then touch Promote. The device moves the job as far
forward as possible in the job queue.
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Cancel faxes
You can cancel outgoing faxes that are currently scanning or that are waiting in the job queue. You can
also cancel incoming faxes.

Cancel a fax while it is scanning 1. Press Stop. The Job Status screen opens, and a message appears that
confirms the job has been canceled.

2. Touch OK to continue.

Cancel an outgoing fax 1. From the Home screen, touch Job Status.

2. On the Active tab, open the drop-down list named Select Job Type, and select
either Outgoing Faxes or Send and Outgoing Faxes.

3. From the list of jobs, select the job, and then touch Cancel Job.

Cancel an incoming fax 1. From the Home screen, touch Job Status.

2. On the Active tab, open the drop-down list named Select Job Type, and select
Copy, Print, Incoming Fax Jobs.

3. From the list of jobs, select the job, and then touch Cancel Job.

Use Windows PC fax send
If the system administrator has installed it, you can use the Windows PC fax send software to send faxes
from a computer.

Send a fax to a single recipient
1. Open the document that you want to fax in the software program in which it was created.

2. Click File and then click Print.

3. From the list of printers, select the Send Fax driver.

4. Click OK or Print.

NOTE: Click the button that sends a document to the device. This might not be labeled the same
in all software programs.

5. Under Fax To in the Send Fax dialog box, type the recipient name, fax number, and company
name. The fax number is the only required information.

NOTE: See Insert special characters in the fax number on page 38 for a list of special characters
that you can use in the Fax Number text field.

6. Click Add to Phone Book to add the recipient information to the Send Fax phone book. This step
is optional.

NOTE: Click Clear Fields to remove all of the values in the recipient Name, Fax Number, and
Company Name text boxes.

7. The default cover page information appears under Include With Fax in the Send Fax dialog box.
You can change the cover page information for any individual fax job.
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8. If the billing code feature is enabled, and the system administrator has made it editable, type the
billing code under Billing Information in the Send Fax dialog box. You can change the billing code
for any individual fax job.

9. To send the fax with the default settings, click Send.

NOTE: Click the Setup tab in the Send Fax dialog box to view the sender, fax quality, notification
information, and preview settings. You can change this information for any individual fax job. Click
Send to send the fax.

10. If you selected Show Preview Before Sending Fax on the Setup tab, a preview of the fax job
appears. Review the fax for accuracy, and then click Preview and Send to send the fax.

NOTE: The preview function is not available when you use Point and Print.

Point and Print is a Windows feature that you can use to connect, print, or fax to a remote printer
without using installation disks. Files and configuration information are automatically downloaded
from the print server to the client.

11. Click View or use the zoom drop-down menu to change the size of the document preview.

12. Click the arrow buttons to navigate through the document.

13. Click Send Fax to send the fax or Cancel Fax to edit the fax settings.

Send a fax to multiple recipients
1. Open the document that you want to fax in the software program in which it was created.

2. Click File and then click Print.

3. From the list of printers, select the Send Fax driver.

4. Click OK or Print.

NOTE: Click the button that sends a document to the device. This might not be labeled the same
in all software programs.

5. Under Fax To in the Send Fax dialog box, type the recipient name, fax number, and company
name. The fax number is the only required information.

NOTE: See Insert special characters in the fax number on page 38 for a list of special characters
that you can use in the Fax Number text field.

6. Click Add to Phone Book to add the recipient information to the Send Fax phone book. This step
is optional.

NOTE: Click Clear Fields to remove all of the values in the recipient Name, Fax Number, and
Company Name text boxes.

7. Click To to add the recipient to the Fax Recipients field.

8. Repeat this procedure for each fax recipient. The fax is sent to all of the names that appear in the
Fax Recipients field.

9. If the billing code feature is enabled, and the system administrator has made it editable, type the
billing code under Billing Information in the Send Fax dialog box. You can change the billing code
for any individual fax job.
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10. To send the fax with the default settings, click Send.

NOTE: Click the Setup tab in the Send Fax dialog box to view the sender, fax quality, notification
information, and preview settings. You can change this information for any individual fax job. Click
Send to send the fax.

11. If you selected Show Preview Before Sending Fax on the Setup tab, a preview of the fax job
appears. Review the fax for accuracy, and then click Preview and Send to send the fax.

NOTE: The preview function is not available when you use Point and Print.

Point and Print is a Windows feature that you can use to connect, print, or fax to a remote printer
without using installation disks. Files and configuration information are automatically downloaded
from the print server to the client.

12. Click View or use the zoom drop-down menu to change the size of the document preview.

13. Click the arrow buttons to navigate through the document.

14. Click Send Fax to send the fax, or click Cancel Fax to edit the fax settings.

Insert special characters in the fax number
The Fax Number field accepts special characters in addition to the numbers 0 through 9.

Table 2-3  Special characters for fax numbers

Special character Function

- Use a hyphen in the fax number to make the number easier to read.

( and ) Use parentheses in the fax number to make the number easier to read.

[ and ] Use an opening and closing bracket to hide a portion of the fax number so that it does not print on the fax
cover sheet, call reports, or e-mail communications. For example, a fax number might include a calling-
card access code. Type brackets around the calling-card access code portion of the fax number to prevent
showing this information.

* The asterisk is transmitted as a touch-tone.

# The number sign is transmitted as a touch-tone.

, A comma represents a 2-second pause when the fax number is dialed. Use multiple commas for a longer
pause during dialing.

Send a fax by using the phone book
1. Open the document that you want to fax in the software program in which it was created.

2. Click File and then click Print.

3. From the list of printers, select the Send Fax driver.

4. Click OK or Print.

NOTE: Click the button that sends a document to the device. This might not be labeled the same
in all software programs.

5. Under Fax To in the Send Fax dialog box, click the book icon.
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6. In the Phone Book dialog box, select the name for each fax recipient and click To to add the
recipient to the Fax Recipients field.

7. After you have added all of the fax recipients to the Fax Recipients field, click OK.

8. Under Include With Fax in the Send Fax dialog box, clear Cover Page (Single recipient only)
if it is selected.

9. If the billing code feature is enabled, type the billing code under Billing Information in the Send
Fax dialog box. You can change the billing code for any individual fax job.

10. To send the fax to all recipients with the default settings, click Send.

NOTE: Click the Setup tab in the Send Fax dialog box to view the sender, fax quality, notification
information, and preview settings. This information can be changed for any individual fax job. Click
Send to send the fax.

11. If you selected Show Preview Before Sending Fax on the Setup tab, a preview of the fax job
appears. Review the fax for accuracy.

NOTE: The preview function is not available when you use Point and Print.

Point and Print is a Windows feature that you can use to connect, print, or fax to a remote printer
without using installation disks. Files and configuration information are automatically downloaded
from the print server to the client.

12. Click View or use the zoom drop-down menu to change the size of the document preview.

13. Click the arrow buttons to navigate through the document.

14. Click Send Fax to send the fax or Cancel Fax to edit the fax settings.

Edit the phone book
Use the phone book to store contact information that appears under Fax To in the Send Fax dialog box.
You can add or remove names.

The Send Fax phone book is saved as an XML file in the My Documents folder. HP does not recommend
editing or copying this file.

Add names to the phone book

To add names to the phone book, do the following:

1. Under Fax To in the Send Fax dialog box, click the book icon.

2. In the Phone Book dialog box, click Add.

3. In the Add to Phone Book dialog box, type the recipient name, fax number, and company name
in the text boxes.

4. Click OK.

5. In the Phone Book dialog box, click Add to add names.

6. Click OK when you are finished adding names to the phone book.
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Remove names from the phone book

To remove names from the phone book, do the following:

1. Under Fax To in the Send Fax dialog box, click the book icon.

2. In the Phone Book dialog box, select the name that you want to delete and then click Delete.

3. Click OK when you are finished removing names from the phone book.

Edit names in the phone book

To edit names in the phone book, do the following:

1. Under Fax To in the Send Fax dialog box, click the book icon.

2. In the Phone Book dialog box, select the name that you want to edit and then click Edit.

3. In the Edit Phone Book Entry dialog box, edit the recipient name, fax number, and company name
in the text boxes.

4. Click OK when you are finished editing.
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Send to e-mail
If the device is connected to a network server that has a valid simple mail transfer protocol (SMTP)
address and has Internet access, you can use the device to scan a document and send it as an e-mail
attachment.

Send a scanned file as an e-mail attachment
1. Place the original document face-down on the glass or face-up in the document feeder.

2. From the Home screen, touch E-mail to open the e-mail feature.

3. For each field, touch the text box to open the virtual keyboard and then type the information. Use
the scroll buttons on the right side of the screen to see all the fields. To use an address from the
e-mail address book, touch the address book button ( ), if it is available, and select a name. For
more information, see Use the e-mail address book on page 42.

NOTE: If the system administrator has configured the device so that you can send e-mail only to
yourself, the address book button does not appear.

From: Type the e-mail address for the person who is sending the e-mail. If the system administrator has
set up a default From: address, this field is already complete, and you might not be able to change
it. If you are signed in to the device, your e-mail address is filled in.

To: Type the recipients' names. To separate the names, type a semi-colon or touch Enter. If the system
administrator has configured this feature so that you can send e-mail only to yourself, this field is
already filled in with your e-mail address, and you cannot change it.

CC: Type the recipients' names. To separate the names, type a semi-colon or touch Enter. If the system
administrator has configured this feature so that you can send e-mail only to yourself, this field is
empty and you cannot change it.

BCC: Type the recipients' names. The other recipients cannot see names in this field. To separate the
names, type a semi-colon or touch Enter. If the system administrator has configured this feature so
that you can send e-mail only to yourself, this field is empty and you cannot change it.

Subject: Type the subject of the e-mail.

File Name: Type the file name to use for the e-mail attachment.

Message: Type a message to deliver with the e-mail. The system administrator might have locked this field.

4. Touch More Options to see other e-mail options. For more information about using customized
settings, see Configure the e-mail options for each job on page 43.

5. After all the options are set, touch Send E-mail ( ) to scan the document and send the e-mail.

6. To verify that the e-mail was sent successfully, open the Home screen and touch Job Status. Touch
the Job Log tab, and look for the e-mail in the list of completed jobs.
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Use the e-mail address book
Use the e-mail address book to store information for e-mail recipients. To open the address book, touch
the address book button ( ) on the main e-mail screen. The button is available for the From:, To:,
CC:, and BCC: fields.

To get more information about any address, select the address in the list on the left side of the screen
and touch Details.

You can add entries to the address book that is stored on the device. You can also edit or delete certain
entries. If you are signed in to the device, addresses that you add are not available to other users.

NOTE: You cannot edit or delete network address entries, and you cannot edit or delete some entries
that have been imported from other address books. For those entries, the buttons for adding, editing,
and deleting are inactive.

Use an address 1. Touch one or more name in the list on the left side of the screen to select them.

2. Touch the right arrow button ( ) to move the names to the list on the right side
of the screen.

3. If you need to remove a name from the list on the right side of the screen, select
the name and then touch the trash button that is below the list.

4. Touch OK to return to main E-mail screen. The name or names should appear
in the correct field.

Add an address 1. Touch the plus button ( ), which is in the lower left corner of the screen. The
virtual keyboard opens.

2. Select each field and type the correct information in the box. The required fields
are marked with an asterisk (*).

3. When you have completed all the information, touch OK to add the name to the
list of contacts and return to the Address Book screen.

If you are signed in to the device, the address is stored in your list of personal
contacts. If you are not signed in to the device, the address is stored in the list
of shared contacts.

Edit an address 1. Touch a name in the list on the left side of the screen to select it.

2. Touch Edit to open the virtual keyboard.

3. To change the information in any field, select the field and then type the correct
information.

4. After you have made all the changes, touch OK to return to the Address
Book screen.

Delete an address 1. Touch a name in the list on the left side of the screen to select it. You can select
multiple names.

2. Touch the trash button.

3. The device prompts you to confirm that you want to delete the addresses.
Touch Yes to delete the addresses and return to the address book screen.
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Configure the e-mail options for each job
The device offers several features for optimizing e-mail attachments. These features are all available
on the E-mail screen.

The E-mail screen consists of two pages. From the first page, touch More Options to go to the next
page.

For details about how to use an option, touch the option, and then touch the help ( ) button in the upper-
right corner of the screen. The following table provides an overview of the e-mail options.

NOTE: Depending on how the system administrator has configured the device, some of these options
might not appear. The options in the table are listed in the order in which they can appear.

Table 2-4  Options for e-mail jobs

Option name Description

Document File Type Use this feature to select the file format for the e-mail attachment.

Original Sides Use this feature to describe the layout for each side of the original document.

Output Quality Use this feature to select the quality for the e-mail attachment. Higher-quality images require
a larger file size than lower-quality images. Larger files take more time to send, and some
recipients might have trouble receiving larger files.

Content Orientation Use this feature to specify the way the content of the original document is placed on the page:
portrait or landscape.

Resolution Use this feature to set the resolution for the e-mail attachment. Higher resolution images have
more dots per inch (dpi), so they show more detail. Lower resolution images have fewer dots
per inch and show less detail, but the file size is smaller.

Original Size Use this feature to describe the page size of the original document.

Color/Black Use this feature to select whether the e-mail attachment is in black & white or in color.

Optimize Text/Picture Use this feature to optimize the output for a particular type of content. You can optimize the
output for text or printed pictures, or you can manually adjust the setting.

Notification Use this feature to receive notification about the status of an e-mail attachment that you have
sent. You can receive an e-mail notification, or you can print the notification.

Image Adjustment Use this feature to improve the overall quality of the file. For example, you can adjust the
darkness, sharpness, and contrast, and you can use the Background Cleanup setting to remove
faint images from the background or to remove a light background color.

Job Build Use this feature to combine several sets of original documents into one e-mail attachment. Also
use this feature to scan an original document that has more pages than the document feeder
can accommodate at one time.
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Send to a network folder
If the device is connected to a network, and if the system administrator has enabled this feature, you
can scan a document and save it as a file in a folder on the network.

Send a scanned file to a network folder
NOTE: Depending on how the system administrator has configured the device, you might need to sign
in to the device to use this feature.

1. Place the original document face-down on the glass or face-up in the document feeder.

2. From the Home screen, touch Network Folder to open the network folder feature.

3. Specify the folder where you want to store the file in one of these ways:

● Select one of the Quick Access Folders from the list. These are folders that the administrator
has set up.

● Touch the box below Network Folder Path: to open the virtual keyboard. Type the network
path to the folder.

4. Specify the name for the file by touching the box below File Name:. The virtual keyboard opens.
Type the name to use for the file. You do not need to type the file-type extension. It is added
automatically based on the document file-type setting.

NOTE: The administrator sets the default file type to use. If you want to use a different file type,
touch More Options, and open the Document File Type option.

5. Touch More Options to see other network folder options. For more information about using
customized settings, see Set the folder options on page 45.

6. After all the options are set, touch the Send to Network Folder button ( ) to scan the document
and send the file.

7. To verify that the file was sent successfully, open the Home screen and touch Job Status. Touch
the Job Log tab, and look for the file in the list of completed jobs.
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Set the folder options
The device offers several features for optimizing files that are stored in network folders. These features
are all available on the Network Folder screen.

The Network Folder screen consists of two pages. From the first page, touch More Options to go to the
next page.

For details about how to use an option, touch the option, and then touch the help ( ) button in the upper
right corner of the screen. The following table provides an overview of the options for saving a file in a
network folder.

Table 2-5  Options for network folder jobs

Option name Description

Document File Type Use this feature to select the file format for the saved file.

Original Sides Use this feature to describe the layout for each side of the original document.

Output Quality Use this feature to select the quality for the file. Higher-quality images require a larger file size
than lower-quality images, and they take more time to send.

Content Orientation Use this feature to specify the way the content of the original document is placed on the page:
portrait or landscape.

Resolution Use this feature to set the resolution for the file. Higher resolution images have more dots per
inch (dpi), so they show more detail. Lower resolution images have fewer dots per inch and
show less detail, but the file size is smaller.

Original Size Use this feature to describe the page size of the original document.

Color/Black Use this feature to select whether the file is in black & white or in color.

Optimize Text/Picture Use this feature to optimize the output for a particular type of content. You can optimize the
output for text or printed pictures, or you can manually adjust the setting.

Notification Use this feature to receive notification about the status of the file after you send it. You can
receive an e-mail notification, or you can print the notification.

Image Adjustment Use this feature to improve the overall quality of the file. For example, you can adjust the
darkness, sharpness, and contrast, and you can use the Background Cleanup setting to remove
faint images from the background or to remove a light background color.

Job Build Use this feature to combine several sets of original documents into one file. Also use this feature
to scan an original document that has more pages than the document feeder can accommodate
at one time.
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Job Storage
You can store jobs on the device so you can print them at any time. You can share stored jobs with
other users, or you can make them private.

Store jobs at the device

1. Place the original document face-down on the glass or face-up in the document feeder.

2. From the Home screen, touch Job Storage to open the Job Storage feature. Select the Create tab.

3. Specify the name for the stored job in one of these ways:

● Select an existing folder from the list. Touch New Job and type a job name.

● Touch the box below the existing Folder Name: or Job Name:, and then edit the text.

4. A private stored job has a lock icon next to the name, and it requires that you specify a PIN to
retrieve it. To make the job private, select PIN to Print and then type the PIN for the job.

5. Touch More Options to see other job storage options. For more information about using customized
settings, see Configure the job storage options on page 47.

6. After all the options are set, touch the Create Stored Job button ( ) to scan the document and
store the job. The job is saved on the device until you delete it, so you can print it as often as
necessary.

If you are signed in to the device, the job is stored in a folder with your sign-in name. If you are not
signed in to the device, the job is stored in a public folder.

For information about retrieving the job, see Retrieve stored jobs on page 49.
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Store jobs from a computer
In addition to scanning a document at the device control panel and storing it, you can also send a job
from a computer and store it on the device. Use the printer driver to do this. When you store a job from
a computer, you have several options for types of jobs to store.

Table 2-6  Types of stored jobs

Job-storage option Description

Proof and Hold The job is sent to the device for short-term storage. If you need to print multiple
copies of a job but you want to verify how they appear before printing them all, use
this feature. The job is sent to the device and printed one time. At the device control
panel, you can choose to print the remaining copies or to cancel the job. After the
copies are printed, the job is deleted.

Personal Job The job is stored on the device until you, or someone else, retrieves it at the device.
If you specify a 4-digit PIN, the person who retrieves the job must provide the PIN.

The device automatically deletes the job after it is printed.

Quick Copy The job is sent to the device and printed one time. It is stored on the device so you
can print more copies as needed.

Stored Job The job is stored on the device until you delete it. It is not printed until you, or
someone else, retrieves it at the device. If you specify a 4-digit PIN, the person who
retrieves the job must provide the PIN.

Use this option for storing documents that are shared by many users.

For details about how to use the printer driver to store jobs, see the following sections:

● Set the color options on page 61

● Macintosh printer driver features on page 62

Configure the job storage options
The device offers several features for optimizing jobs that are scanned at the device and stored. These
features are all available on the Job Storage screen when you create the stored job.

NOTE: These features are not available when someone retrieves the job for printing.

The Job Storage screen consists of four pages. From the first page, touch More Options to go to the
next page.

For details about how to use an option, touch the option, and then touch the help ( ) button in the upper-
right corner of the screen. The following table provides an overview of the job storage options.

NOTE: Depending on which accessories are installed, some of these options might not appear. The
options in the table are listed in the order in which they can appear.

Table 2-7  Options for stored jobs

Option name Description

Paper Selection Use this feature to select the tray that holds the size and type of paper that you want to use.

Image Adjustment Use this feature to improve the overall quality of the file. For example, you can adjust the
darkness, sharpness, and contrast, and you can use the Background Cleanup setting to remove
faint images from the background or to remove a light background color.
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Option name Description

Content Orientation Use this feature to specify the way the content of the original page is placed on the page: portrait
or landscape.

Output Bin Use this feature to select an output bin for the copies. If the optional HP Multifunction Finisher
is attached, stapled copies are always delivered to Output Bin 5.

Pages per Sheet Use this feature to copy multiple pages onto one sheet of paper.

Watermark Use this feature to print a string of text diagonally across the center of each page.

Overlays Use this feature to print a semi-transparent image on each page. Overlays are similar to
watermarks, but overlays can consist of any image, such as a company logo.

Chapter Pages Use this feature to copy documents that have chapters. You can specify that the chapters
always begin on either the left or right page. If necessary, the device inserts blank pages so
the first page of each chapter is on the correct side.

Stamp Date/Time Use this feature to print the date and time on copies. You can control the numbering style and
the position of the information.

Stamp Page Number Use this feature to print page numbers on copies. You can control the numbering style and the
position.

Stamp Text Use this feature to print a predefined text message on the copies or print a message that you
specify. A text stamp is similar to a watermark, but you can control the position on the page
and the angle.

Stamp Set Number Use this feature to print the set number on copies. For example, if you are making five copies
of a document, each page in the first set of copies is stamped with the number 1.

Edge-To-Edge If the original document is printed close to the edges, use this feature to ensure that the
maximum amount of content is copied. However, shadows might appear along the edges.

Image Shift Use this feature to shift the image on the page.

Image Repeat Use this feature to copy the same image multiple times on a single sheet of paper. To use this
feature, place the original on the flatbed glass, and leave the cover open.

Table 2-7  Options for stored jobs (continued)
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Retrieve stored jobs
At the device, you can retrieve and print jobs that are stored on the device, whether they were scanned
at the device or sent from a computer.

NOTE: Depending on how the system administrator has configured the device, you might need to sign
in.

You cannot retrieve or print a stored job if you do not have permission to print in color. The device
provides an alert in this situation.

1. From the Home screen, touch Job Storage to open the Job Storage feature. Select the Retrieve
tab.

2. From the list on the left side of the screen, select the folder in which the job is stored. A list of stored
jobs appears.

3. Select the job from the list. If the job is private, touch the box below PIN: and type the correct PIN.

4. Touch the Retrieve Stored Job button ( ) to print the job.

The device retains most jobs until you delete them, but it automatically deletes certain jobs as soon as
you print them.

Type of stored job Action after printing

All public and private stored jobs that are scanned at the device Retained on the device hard disk

Stored jobs that are sent from a computer Retained on the device hard disk

Quick Copy stored jobs, sent from a computer Retained on the device hard disk

"Personal job" jobs, sent from a computer Deleted automatically after printing

Proof and Hold stored jobs, sent from a computer Deleted automatically after the subsequent copies are printed

Delete stored jobs
To delete stored jobs, open the Job Storage feature on the device control panel.

1. From the Home screen, touch Job Storage.

2. Select the Retrieve tab.

3. Open the folder in which the job is stored, and then select the job.

4. Touch Delete.

5. Repeat the process for each stored job that you want to delete.
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Check job status and use the job queue
To check the status of individual jobs, use the Job Status feature on the device control panel. Also use
this feature to pause all jobs, remove jobs from the queue, or to promote a job so it is processed sooner.

Open the job queue
1. From the Home screen, scroll to and touch Job Status. The job queue opens.

2. The Active tab shows jobs that are currently processing. From the drop-down menu, select a job
category, and then select the name of the job.

NOTE: The system administrator can configure the device so that you cannot cancel, promote,
or see the details for jobs that are not your own.

● Touch Pause All to stop all active jobs.

CAUTION: As long as the device is in a paused state, it will not process incoming print jobs.
It will remain in this state until Resume All is selected on the control panel.

● Touch Cancel Job to cancel the selected job and remove it from the job queue.

● Touch Details to see the information about the selected job.

● Touch Promote to move the selected job forward in the job queue so it can be completed as
soon as possible. For more information, see Promote and interrupt jobs in the queue
on page 52.

3. The Job Log tab lists all the completed jobs. From the drop-down menu, select a job category, and
then select the name of the job. Touch Details to see the information about the selected job.

NOTE: The Job Log feature lists only jobs that the user is authorized to view. The user might be
required to log in at the control panel to use this feature.
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Process multiple job types
The device processes multiple jobs simultaneously whenever it can. This is possible because the
scanner, the print engine, and the digital send features can function at the same time for separate jobs.
For example, the device can be receiving a fax, sending a fax, or sending out a digital send job while
scanning a copy job and while printing a job from a remote user. It can also allow some types of jobs to
interrupt jobs in process depending on settings and on priority.

The administrator can control the priority of incoming print jobs using the Hold Off Print Job feature. This
feature provides the option of delaying incoming print jobs while users are copying or using the stored
job features at the device. When the Hold Off Print Job feature is On, incoming print jobs are delayed
until jobs in process at the device are finished. When the Hold Off Print Jobs feature is Off, the device
places incoming print jobs in the queue immediately even if they interrupt copy jobs or stored jobs.

NOTE: The Hold Off Print Job feature only affects processes that involve printing. Otherwise, the
device places incoming jobs in the queue as soon at it receives them.
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Promote and interrupt jobs in the queue
When the device is processing multiple jobs, in most cases it prioritizes them according to the order in
which it receives them. However, some types of jobs automatically take priority over others. You can
also promote a job in the queue so it is processed as soon as possible, or you can interrupt a job that
is in progress so a new job is processed immediately.

Job priorities
The device prioritizes jobs in the following order, with the highest priority listed first:

1. Any job that you have specifically promoted in one of the following ways:

◦ By using the Promote option in the Job Status feature on the device control panel.

◦ By pressing the Interrupt button on the device control panel.

Promoting a job by using either of these methods causes the current job to be interrupted
immediately. See Job interruption on page 53.

2. Jobs that are started at the device:

◦ copy jobs

◦ job-storage jobs

◦ print internal pages

Starting any of these jobs causes the current job to be interrupted immediately. See Job interruption
on page 53.

3. Jobs that are sent from a computer and incoming faxes. These jobs do not interrupt current jobs.
If someone is currently using the device control panel, these jobs are held until that person is
finished. However, the administrator can configure the Hold Off Print Job setting to Off to prevent
these jobs from being held off by user activity at the device control panel.
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Job interruption
The device can interrupt a job that is currently printing at these boundaries:

● After a complete page, but in the middle of a multiple-page job. If the current job is being printed
on both sides, the interruption occurs after both sides have printed.

NOTE: If the current job requires stapling, the new job interrupts the current job after a complete
set of pages.

● After a complete set of pages for jobs that have multiple copies.

The type of interruption that occurs depends on the type of job that is being promoted or started.

● Starting a copy job interrupts the current job after a complete page, unless the current job requires
stapling.

● Printing an internal page or a stored job interrupts the current job after a complete set of pages.

● Printing a job from a computer or printing an incoming fax does not interrupt the current job, unless
you promote the new job in one of the following ways:

� By using the Promote option in the Job Status feature on the device control panel.

� By pressing the Interrupt button on the device control panel.

If you promote the new job, it interrupts the current job after a complete set of pages.

● Pressing the Interrupt button on the device control panel interrupts the current job after a complete
set of pages.
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Print from a Windows computer
The device comes with printer drivers that the computer uses to communicate with the device. Printer
drivers provide access to device features, such as printing on custom-sized paper, resizing documents,
and inserting watermarks.

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: Make sure that the device is available in the list of printers before sending a print job to the
device.

Windows printer driver features
NOTE: Settings in the printer driver and software program generally override control-panel settings.
Software-program settings generally override printer-driver settings.

Select a tray
Use the printer driver to select a tray for the print job by doing the following:

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Paper/Quality tab, select the tray from the Paper source drop-down menu.

4. Click OK.

Select an output bin for print jobs
If the optional finisher is installed, use the printer driver to select an output bin for the print job by doing
the following:

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Output tab, select the output bin from the Output Bin Options drop-down menu.

NOTE: All stapled output is delivered to Output Bin 5.

4. Click OK.

Select a paper type
Rather than instructing the device to use a specific tray, you can specify that the job is printed on a
particular type of paper. The device uses a tray that contains that type of paper, or it prompts you to
load the correct type.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Paper type drop-down box, select the type of paper to use.
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Set the color quality
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the area for Print Quality for the Color Quality, select either Professional or General Office.

Store jobs
Use the Job Storage printer-driver tab to store print jobs on the device. You can then print the job at
any time from the device control panel. For example, you might want to download a personnel form,
calendar, timesheet, or accounting form that other users can print when they need it.

Enable the Job Storage tab

You might need to enable the Job Storage tab before you can use this feature.

1. Click Start, click Settings, and then click Printers or Printers and Faxes.

2. Right-click the driver icon, and then select Properties.

3. Click the Device Settings tab.

4. Under Installable Options, click next to Job Storage, and click Enabled.

5. Click Apply.

Store a job

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Job Storage tab.

4. Select the job storage mode and options that you want to use.

NOTE: The text box at the top of the Job Storage tab describes each option as you select it.

5. Click OK.

Create and use printing shortcuts
Use printing shortcuts to print jobs with specific printer-driver settings. Select one of the defined shortcuts
or create custom printing shortcuts.

Create a printing shortcut

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Select the print settings that you want to use.

4. Click the Printing Shortcuts tab, and then click Save as.
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5. In the Printing Shortcuts box, type a name for the custom printing shortcut.

6. Click OK.

Use printing shortcuts

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Printing Shortcuts tab.

4. Select the printing shortcut that you want to use from the Printing Shortcuts list.

5. Click OK.

Use watermarks
A watermark is a notice, such as "Confidential," that is printed in the background of each page of a
document.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. From the Effects tab, click the Watermarks drop-down list.

4. Click the watermark that you want to use. To create a new watermark, click Edit.

5. If you want the watermark to appear only on the first page of the document, click First Page
Only.

6. Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.

Resize documents
Use the document resizing options to scale a document to a percentage of its normal size. You can also
choose to print a document on a different size paper, with or without scaling.

Reduce or enlarge a document

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Effects tab, next to % of Actual Size, type the percentage by which you want to reduce or
enlarge your document.

You can also use the scroll bar to adjust the percentage.

4. Click OK.

Print a document onto a different paper size

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.
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3. On the Effects tab, click Print Document On.

4. Select the paper size to print on.

5. To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.

6. Click OK.

Set a custom paper size
1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. On the Paper/Quality tab, click Custom.

4. On the Custom Paper Size window, type the name of the custom paper size.

5. Type the paper-size length and width. If you type a size that is too small or too large, the driver
adjusts the size to the minimum or maximum size that is allowed.

6. If necessary, click the button to change the unit of measure between millimeters and inches.

7. Click Save.

8. Click OK. The name that you saved appears in the paper-size list for future use.

Print using different paper
Follow these instructions to print specific pages of the job on different paper.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Page exceptions list box, click Print pages on different paper.

5. Click Settings.

6. Select the settings that you want to use to print specific pages on different paper. Click Add.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.

Insert blank or preprinted sheets
Follow these instructions to insert blank or preprinted sheets in the print job.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Page exceptions list box, click Covers.

5. Click Settings.
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6. Select the settings that you want to use to add blank or preprinted sheets.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.

Chapter page layout
Follow these instructions to set the layout of chapters in the print job.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Paper/Quality tab.

4. In the Page exceptions list box, click Chapter page layout.

5. Click Settings.

6. Select the settings that you want to use to for the layout of the chapters in the print job.

7. Click OK to return to the Paper/Quality tab.

8. Click OK.

Print on both sides of the paper
You can automatically print on both sides of a page.

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper, see Load special types of paper on page 25.

2. On the File menu in the software program, click Print.

3. Select the driver, and then click Properties or Preferences.

4. On the Finishing tab, click Print on Both Sides.

5. Click OK.

Layout options for printing on both sides

The four duplex orientation options are shown here. To select option 1 or 4, select Flip Pages Up in the
printer driver.

1 2 3 4
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1. Long-edge landscape Every other printed image is oriented upside-down. Facing pages are read
continuously from top to bottom.

2. Short-edge landscape Every printed image is oriented right-side-up. Facing pages are read from top to
bottom.

3. Long-edge portrait This is the default setting, and the most common layout used. Every printed image
is oriented right-side-up. Facing pages are read from top to bottom.

4. Short-edge portrait Every other printed image is oriented upside-down. Facing pages are read
continuously from top to bottom.

Print multiple pages on one sheet of paper in Windows
You can print more than one page on a single sheet of paper.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Finishing tab.

4. In the section for Document Options, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. If the number of pages is greater than 1, select the correct options for Print Page Borders and
Page Order.

● If you need to change the page orientation, click Portrait or Landscape.

6. Click OK. The product is now set to print the number of pages per sheet that you have selected.

Create booklets
You can copy two pages on one sheet of paper so you can fold the pages in the center to form a booklet.
The device arranges the pages in the correct order. For example, if the original document has eight
pages, the device prints pages 1 and 8 on the same sheet.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Finishing tab.

4. Select Print On Both Sides.
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5. In the drop-down box for Booklet Layout, select either Left Edge Binding or Right Edge
Binding. The Pages per Sheet setting automatically changes to 2 pages per sheet.

6. Click OK.

Shift images on the page
You can adjust the placement of the image on the page toward any edge.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Output tab.

4. Click Image shift settings....

● You can adjust the front and back sides independently by specifying measurements for Front
side shift and Back side shift.

● You can adjust the front and back sides by the same amount, but in opposite directions. This
is useful for creating a wider margin along the binding edge. Select Front side shift, specify
the settings, and then select Mirror front side.

● Select Reduce to fit to shrink the image to accommodate increased margins.

Use the HP Digital Imaging Options dialog box
Use HP Digital Imaging Options to print better-quality photos and images.

Open the HP Digital Imaging Options dialog box

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties.

3. Click the Paper/Quality tab, and then click the HP Digital Imaging button.

The following options are available on the HP Digital Imaging Options dialog box:

● Contrast Enhancement: Enhance colors and contrast for washed-out photos. Click Automatic
to allow the printer software to brighten areas of photos that need adjustment.

● Digital Flash: Adjust the exposure in dark areas of photos to bring out detail. Click Automatic to
allow the printer software to balance lightness and darkness.

● SmartFocus: Enhance the image quality and clarity of low resolution images such as those
downloaded from the Internet. Click On to allow the printer software to sharpen details in the image.

● Sharpness: Adjust the image sharpness to your preference. Click Automatic to allow the printer
software to set the level of sharpening for the image.

● Smoothing: Soften an image. Click Automatic to allow the printer software to set the level of
smoothing for the image.
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Set the stapling options

Configure the driver to recognize the finisher

If the HP Multifunction Finisher is installed, but the stapling options do not appear in the printer driver,
you need to configure the driver to recognize the finisher.

1. Click Start, click Settings, and then click Printers or Printers and Faxes.

2. Right-click the driver icon, and then select Properties.

3. Click the Device Settings tab. (The Device Settings tab is not available from within software
programs.)

4. In the area for configuring installable options, select the HP Multifunction Finisher, and then click
OK.

Set the stapling options for each job

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Output tab.

4. In the Staple box, select the stapling option that you want to use for the print job.

5. Click OK.

Set the color options
Options on the Color tab control how colors are interpreted and printed from software programs.

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

3. Click the Color tab.

4. In the Color Options area, select the option that you want to use.

5. Click More color options... to open the Advanced Color Settings dialog box. Adjust the individual
settings for cyan, magenta, yellow, and black. Click OK.

6. In the Color Themes area, select the RGB Color option that you want to use.

7. Click OK.

Use the Services tab
If the device is connected to a network, use the Services tab to obtain device and supply-status
information. Click the Device and Supplies status button to open the Device Status page of the
embedded Web server. This page shows the current status of the device, the percentage of life
remaining for each supply, and information for ordering supplies.
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Print from a Macintosh computer
The device comes with printer drivers that the computer uses to communicate with the device. Printer
drivers provide access to device features, such as printing on custom-sized paper, resizing documents,
and inserting watermarks.

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: Make sure that the device is available in the list of printers before sending a print job to the
device.

Macintosh printer driver features
NOTE: Settings in the printer driver and software program generally override control-panel settings.
Software-program settings generally override printer-driver settings.

Select a tray
You can print all pages on the same paper, or you can print the first page on one type of paper and print
the remaining pages on a different type of paper.

1. On the File menu, click Print.

2. Open the Paper Feed menu.

3. To print all pages on the same paper, select All pages from, and then open the drop-down list
and select which tray to use.

4. To print the first page on a different type of paper than the remaining pages, select First page
from, open the drop-down list, and select the tray. Also select the tray for Remaining pages
from.

Select an output bin
1. On the File menu, click Print.

2. Open the Finishing menu.

3. On the Finishing tab, next to Output Destination, select which output bin to use.

NOTE: All stapled output is delivered to Output Bin 5.

Select a paper type
Rather than instructing the device to use a specific tray, you can specify that the job is printed on a
particular type of paper. The device uses a tray that contains that type of paper, or it prompts you to
load the correct type.

1. On the File menu, click Print.

2. Open the Finishing menu.

3. On the Finishing tab, next to Media Type, select the type of paper to use.
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Set the color quality
1. On the File menu, click Print.

2. Open the Color/Quality Options menu, and select the Basic tab.

3. To print in color, select Color Print. Next to Color Quality, select either Professional or General
Office.

Store jobs
You can store jobs on the device so you can print them at any time. You can share stored jobs with
other users, or you can make them private.

1. On the File menu, click Print.

2. Open the Job Storage menu.

3. Next to Job Storage Mode, select the type of stored job.

4. If you selected Stored Job or Personal Job in the previous step and you selected Use PIN To
Print, type a 4-digit number in the box. When other people attempt to print this job, the device
prompts them to type this PIN number.

Create and use presets
Use presets to save the current printer driver settings for reuse.

Create a preset

1. On the File menu, click Print.

2. Select the print settings.

3. In the Presets box, click Save As..., and type a name for the preset.

4. Click OK.

Use presets

1. On the File menu, click Print.

2. In the Presets menu, select the preset that you want to use.

NOTE: To use printer-driver default settings, select the Standard preset.

Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.

1. On the File menu, click Print.

2. Open the Watermarks menu.

3. Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4. Next to Pages, select whether to print the watermark on all pages or on the first page only.
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5. Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6. Select options for the remaining settings.

NOTE: Transparent watermarks are not available for all applications.

Resize documents 
You can scale a document to fit on a different size of paper.

1. On the File menu, click Print.

2. Open the Paper Handling menu.

3. In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print on a custom paper size
You can print on a custom paper size.

1. On the File menu, click Page Setup.

2. (OS X v10.3) From the Settings drop-down list, select Custom Paper Size, and specify the
dimensions.

-or-

(OS X v10.4 and later) From the Paper Size drop down list, select Manage Custom Sizes, add
the new size, and then specify the dimensions.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).

1. On the File menu, click Print.

2. On the Cover Page pop-up menu, select whether to print the cover page Before document or
After document.

3. In the Cover Page Type pop-up menu, select the message that you want to print on the cover
page.

NOTE: To print a blank cover page, select Standard as the Cover Page Type.

Print on both sides of the paper
You can automatically print on both sides of a page.

1. Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper, see Load special types of paper on page 25.

2. On the File menu, click Print.
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3. Open the Layout pop-up menu.

4. Next to Two-Sided, select either Long-Edge Binding or Short-Edge Binding.

NOTE: For OS X v10.5, a default binding value may appear if you had checked Two-Sided first.

Print multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1. On the File menu, click Print.

2. Click the Layout pop-up menu.

3. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

4. Next to Layout Direction, select the order and placement of the pages on the sheet.

5. Next to Border, select the type of border to print around each page on the sheet.

Create booklets
You can copy two pages on one sheet of paper so you can fold the pages in the center to form a booklet.
The device arranges the pages in the correct order. For example, if the original document has eight
pages, the device prints pages 1 and 8 on the same sheet.

1. On the File menu, click Print.

2. Open the Finishing menu.

3. On the Booklet Printing tab, select Format Output As Booklet.

4. If the last page of the original document should be placed as the back cover of the booklet, select
Last Page Is Back Cover.

5. Next to Page Order, select whether the pages should be bound on the left or right edge.

6. Next to Scaling, select Proportional, or Fit To Page.

7. Next to Paper For Booklet, select the paper size to use.
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Shift images on the page
You can adjust the placement of the image on the page toward any edge.

1. On the File menu, click Print.

2. Open the Finishing menu.

3. On the Image Shift tab, select the appropriate settings.

● You can adjust the front and back sides independently by specifying measurements for Front
Side Shift and Back Side Shift.

● You can adjust the front and back sides by the same amount, but in opposite directions. This
is useful for creating a wider margin along the binding edge. Select Front Side Shift, specify
the settings, and then select Mirror Front Side.

● Select Reduce to Fit to shrink the image to accommodate increased margins.

Set the stapling options
If the HP Multifunction Finisher is installed, you can staple documents.

1. On the File menu, click Print.

2. Open the Finishing menu, and select Output Bin 5 for the Output Destination.

3. On the Finishing tab, next to Finishing Options or Staple, select the stapling option that you want
to use.

Set the color options
Use the Color/Quality Options menu to control how colors are interpreted and printed from software
programs.

1. On the File menu, click Print.

2. Open the Color/Quality Options menu.

3. Select the color options that you want to use.

Use the Services menu
If the device is connected to a network, use the Services menu to obtain device and supply-status
information.

1. On the File menu, click Print.

2. Open the Services menu.

3. Select a maintenance task from the drop-down list, and then click Launch. The embedded Web
server opens to the page that provides the information for the task that you selected.
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3 Maintain the device

This chapter contains information about the following topics:

● Replace ink cartridges

● Replace staple cartridges

● Clean the device
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Replace ink cartridges
The device uses four color ink cartridges and one bonding agent cartridge. The bonding agent adheres
the ink to the paper and improves the durability of the printed output.

A message appears on the control panel whenever a cartridge needs to be replaced. The control-panel
message tells you which cartridge needs to be replaced.

An ink cartridge expires twelve months after the date of installation if it is installed prior to the install-by
date shown on the ink cartridge package. If it is installed after the install-by date, the ink cartridge will
expire in less than twelve months.

NOTE: The bottom of each cartridge has a unique shape so it fits only into its corresponding slot.

1. Open the ink-cartridge door.
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2. Push the cartridge back and then up to release it, then pull the cartridge straight out.

3. Push the new cartridge straight in until it locks into place.

4. Please return your genuine HP supplies for recycling to Hewlett-Packard. For more information,
please visit us at www.hp.com/go/recycle.

NOTE: On the Supplies Status Page, the HP logo only appears in front of the supply name when
genuine HP supplies are used.
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Replace staple cartridges
NOTE: The HP Multifunction Finisher is an optional accessory. Other finishers do not have staplers.

A message appears on the control panel whenever a staple cartridge needs to be replaced. The optional
HP Multifunction Finisher has two staplers. Stapler 1 is on the right, closest to the device. Stapler 2 is
to the left and above Stapler 1. The control-panel message indicates which stapler is empty.

CAUTION: To avoid injury, do not reach into the device to change the staple cartridge while the device
is operating.

1. Open the stapler door.

2. To remove the staple cassette, pull forward on the green lever that is on the front of the staple
cassette, and then pull the staple cassette straight out.
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3. To remove the staple cartridge from the cassette, push in at the arrow on each side and then pull
up to release the cartridge.

4. Insert the new staple cartridge into the staple cassette. Push the cartridge straight down until it
snaps into place.

5. Push the staple cassette straight into the slot.
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6. Rotate the green lever up until it snaps into place.

7. Close the stapler door.
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Clean the device
The device does not need to be cleaned often. However, if dirt is visible on the flatbed glass or on the
white-vinyl backing, or if streaks or spots appear in copies, clean the flatbed glass and the white-vinyl
backing. Clean the outside of the device and the touchscreen periodically to avoid getting dirt on the
flatbed glass and the white-vinyl backing.

Use the following information to clean the device.

Clean the outside of the device
Clean the outside of the device with a soft, lint-free cloth
dampened with water, or with water and a mild detergent.

Clean the touchscreen

HP CM8060 Color MFP with Edgeline Technology

Clean the touchscreen by gently wiping it with a lint-free cloth
dampened with water. Do not pour or spray water directly onto
the touchscreen. Do not use any other liquid. Solvents and
cleaners can damage the touchscreen.
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Clean the flatbed glass
Clean the flatbed glass only if dirt is visible or if streaks or spots
appear in copies.

Gently wipe the glass with a lint-free cloth dampened with
water. If water does not work, use a cloth dampened with
isopropyl alcohol. Do not pour or spray the cleaner directly onto
the glass. Do not press hard on the glass.

Clean the glass scanner strip
The small glass strip that is to the left of the flatbed glass has
a special coating. Use only gentle pressure when cleaning this
glass strip. Wipe the glass scanner strip with a clean, dry lint-
free cloth. Only if necessary, use a slightly water-dampened
lint-free cloth to clean the glass strip.

CAUTION: Never pour or spray liquids directly onto the glass
scanner strip. Only use gentle pressure when cleaning the
glass scanner strip.

Clean the white-vinyl backing
Clean the white-vinyl backing that is under the flatbed cover
only if dirt is visible or if spots appear in copies.

Gently wipe the backing with a lint-free cloth dampened with
water. If water does not work, use a cloth dampened with
isopropyl alcohol. Do not pour or spray the cleaner directly onto
the backing.
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4 Solve problems

This chapter contains information about the following topics:

● System administrator

● Problem-solving checklists

● Control-panel messages

● Clear jams

ENWW 75



System administrator
The system administrator is a person in your organization who is responsible for configuring and
maintaining the device. This person has access to more in-depth information about solving problems.
You should be able to resolve basic problems without the help of the system administrator. If you
discover a problem that you cannot resolve, contact the system administrator for help.
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Problem-solving checklists
If the device is not responding correctly, complete the steps in the following checklists. If you discover
a problem that you cannot resolve, contact the system administrator for help.

Problems with all jobs
1. Make sure at least one status light on the control panel is lit. If no lights are on, complete these

steps:

a. Press the on/off button on the control panel.

b. Check the master power switch at the right-rear corner of the device. Make sure it is in the on
position.

c. Check the power cable to see if it is securely connected at both ends.

d. Check the power source by plugging the device directly into the wall or into a different outlet.

2. If the device is receiving power but is not responding, check the cabling. Make sure the network
cable is secure.

3. Check the status line on the control panel for messages. See Control-panel messages
on page 79.

Problems with copy and scan jobs
1. For copy jobs, make sure that paper is loaded in the tray you are trying to use.

2. If you are trying to use the document feeder, try scanning from the glass. If the job is successful,
the problem is with the document feeder. Contact the system administrator.

3. If you cannot scan with the document feeder or from the glass, the problem is with the scanner
mechanism. Contact the system administrator.

Problems with print jobs
1. Make sure that paper is loaded in the tray you are trying to use.

2. Print a configuration page. From the Home screen, touch Administration. Touch Information, and
then touch Configuration Page.

a. If the configuration page does not print, make sure paper is loaded in the tray. Also check the
control panel to see if the page has jammed inside the device. See Clear jams
on page 80.

If the tray has paper and the page did not jam, the problem is with the device hardware. Contact
the system administrator.

b. If the configuration page prints, the device hardware is printing correctly. The problem is with
the computer, the printer driver, the network, or with the software program. Continue with the
next step.
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3. At the computer, check to see if the print queue is stopped, paused, or set to print offline.

● Windows: Click Start, click Settings, and then click Printers or Printers and Faxes. Double-
click HP CM8060 Color MFP with Edgeline Technology.

● Macintosh: Open Print Center, or Setup Utilities, or Print and Fax under System
Preferences, and double-click the line for the HP CM8060 Color MFP with Edgeline
Technology.

4. Try printing a document from a different software program. If the document prints, the problem is
with the software program that you are using.

5. Try sending a print job from a different computer. If the document prints, the problem is with the
computer you are using.

6. If you cannot identify the source of the problem, contact the system administrator for help.
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Control-panel messages
The status line on the touchscreen alerts you of potential problems with the device.

Errors: If the device has an error, a message appears that describes the error. The message also has
instructions for solving the problem. The error button ( ) remains on the status line until the error is
resolved.

Warnings: The warning button ( ) appears when the device has a problem but can continue
functioning. Touch the warning button to see a message that describes the problem. The message also
has instructions for solving the problem.

If you are unable to resolve any error or warning messages, contact the system administrator for help.
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Clear jams
If a jam occurs, a message appears on the control panel to describe where the jam is located. The
message also contains instructions for finding the jam, including a short video that shows which
components to move and which doors to open.

Precautions for clearing jams
WARNING! To avoid injury, do not touch moving parts. Do not reach into the device except to clear
jams, to replace ink cartridges, or to add or remove paper.

WARNING! To avoid injuring your fingers, do not attempt to clear a staple jam while the device is
processing other jobs. Wait until the control-panel message prompts you to clear the jam.

CAUTION: To protect the printheads from electrostatic discharge, be sure to touch the horizontal metal
bar to ground yourself before clearing jams that are near the printheads. The printheads are above the
print-drum area.

CAUTION: Be careful not to get ink on your skin or clothes when clearing jams. If ink gets on your
skin or clothes, wash with warm soap and water.

Method for clearing jams
1. On the device, lighted amber arrows indicate which door to open to find the jam. Open the door

and look for more lighted amber arrows. The lights indicate which component to open next in order
to locate the jammed paper.

NOTE: Open only the doors and panels indicated by the lights.

2. To remove the jammed paper, grasp it and carefully pull it out of the device. If the paper tears, be
sure to remove all of the torn pieces.

3. After clearing the jam, close all the doors. Before it continues processing the job, the device clears
any remaining paper in the paper path. The device reprints the jammed pages and then continues
printing the job.
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Prevent jams
Follow these guidelines to prevent jams.

● When loading paper into the trays, always make sure the tray is configured for the correct type of
paper.

● Load full reams of paper into Trays 2, 3, 4, and 5. Do not divide the reams into smaller sections
when loading paper.

● Use only the types of paper that the device supports. See Copy on page 28.

● When using the document feeder, remove staples, paper clips, adhesive papers, and any other
objects that are attached to the original document.

● Always feed paper short-edge first. See the labels on each tray for the correct way to load paper.

● When loading Edgeline Glossy paper into Tray 1, fan the paper stack to separate the sheets before
placing them in the tray. This helps prevent the sheets from sticking together.

● Before using any paper, verify that it is of good quality and is free of cuts, nicks, tears, spots, loose
particles, dust, wrinkles, curls, or bent corners.

CAUTION: To prevent jams and to maintain print quality, make sure that each tray is configured
correctly for the paper type it contains.
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A Regulatory statements

This appendix contains information about the following topics:

● FCC regulations

● Declaration of conformity

● Hewlett-Packard limited warranty statement
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy, and if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area is likely
to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class A limits of Part 15 of FCC rules.
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Declaration of conformity
Declaration of Conformity
according to ISO/IEC Guide 22 and EN 45014
Manufacturer’s Name: Hewlett-Packard Company
Manufacturer's Address: 60 Alexandria Terrace,

#07-01 The Comtech
Singapore, 118502,

declares, that the product

Product Name: HP CM8060/CM8050 MFP
Regulatory Model: VCVRA-0609
Product Options: All
conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2001 / EN60950-1: 2001
IEC 60825-1:1993 +A1+A2 / EN 60825-1:1994 +A1 +A2 (Class 1 for LEDs)

EMC: EN55022: 1998 +A1 +A2 / Class A / CISPR 22:1997 +A1 +A2 Class A
EN 55024:1998 / A1:2001 / A2:2003 / CISPR 24:1997
EN 61000-3-2:2000
EN 61000-3-3:1995 +A1
FCC Title 47 CFR, Part 15 Class A

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC Directive 89/336/EEC, and carries
the CE-Marking accordingly.

The product was tested in a typical configuration.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

For regulatory purposes, this product is assigned a Regulatory Model Number (RMN). This number should not be confused with the product
name or number.

Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment no expressly approved by Hewlett-Packard Company
may cause harmful interference, and void your authority to operate this equipment.

For Regulatory Topics Only:

European Contact Hewlett-Packard Gmbh, Department HQ-TRE, Herrenberger Strasse 140, Böblingen, D-71034, Germany

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 8906 Vancouver, WA 98668-8906, USA
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Hewlett-Packard limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP CM8050/CM8060 Color MFP with Edgeline Technology 90 days (parts only)

HP warrants to the initial purchaser that HP hardware and accessories will be free from defects in
materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either provide component parts
or replace entire products which prove to be defective. Replacement parts or products may be either
new or equivalent in performance to new. These replacement parts or products must be installed by an
HP qualified service technician. HP may replace the entire product only if, in HP’s discretion, service
history, diagnosis and troubleshooting indicate that replacement is warranted. This warranty is limited
to replacement parts only. Cost of labor is not covered under this warranty.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.
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THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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back view (right side) 4
Bin 1

paper sizes supported 19
Bin 2

paper sizes supported 19
Bin 3

paper sizes supported 19
Bin 4

paper sizes supported 19
Bin 5

paper sizes supported 19
bins, output

capacities 19
optional finishers 6
select from Macintosh 62
select from Windows 54
single, locate 5

blank pages, insert from
Windows 57

booklet settings
Macintosh 65
Windows 59

Boot Codes LCD monitor 5
both sides, print on

Macintosh 64
Windows 58

brightness-adjustment dial,
touchscreen

9

brochure, paper for 15
business plan, paper for 15
buttons

control panel 9
touchscreen 12

C
CAN interface 5
cancel

faxes 36
jobs 50

capacities, trays 3
capacities, trays and bins 19
cardstock 14
cartridge door, locate 3
cartridges, ink

Macintosh status 66
replace 68
Windows status 61

cartridges, staple 70
catalog, paper for 15
cautions 2
chapter layout settings,

Windows 58
chart, paper for 15
clean 73
Clear button 9
color

paper, recommended 15
color quality settings

Windows 55
color settings

Macintosh 66
Windows 61

conflicts, job 51
control panel

buttons 9
Help system 12
Home screen 10
lights 9

locate 3
messages 79
sign in 11

conventions, document 2
copy

count 10
from document feeder 28
from glass 29
Job Build option 33
mixed-size originals 29
multitask jobs 51
output bin, default 6
paper, recommended 15
problem-solve 77
settings, adjust 31

cover pages, Macintosh 64
custom-size paper settings

Macintosh 64
Windows 57

D
Data light 9
date 11
declaration of conformity 85
device status

control panel messages 79
Home screen 10
lights 9
Macintosh Services tab 66
Windows Services tab 61

Digital Imaging Options,
Windows 60

document conventions 2
document feeder

capacity 19
copy from 28
locate 3

documents, paper for 14
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doors
jams, clear 80
locate 3

double-sided printing
Macintosh 64
Windows 58

duplex
Macintosh 64
Windows 58

E
e-mail

address book 42
Job Build option 33
multitask jobs 51
options 43
send attachments 41

EIO slot
locate 5

embedded LAN 5
engine interface 5
Engine Power Control 5
enlarging documents 56
envelopes, not supported 14
Error button 12
error messages 79

F
fax

cancel 36
multitask jobs 51
options 34
output bin, default 6
phone book, edit 39
receive 35
send 35
send to multiple recipients 37
send to single recipient 36
send using phone book 38
special characters, insert 38

fax port
locate 5

FCC regulations 84
finishers, optional

CAN interface 5
capacities 19
locate 6
paper sizes supported,

bins 19

select from Macintosh 62
select from Windows 54
See also HP Multifunction

Finisher
flyer, paper for 15
folders, network

Job Build option 33
multitask jobs 51
options 45
send scans to 44

Foreign Interface Harness
(FIH) 5

front door, locate 3

G
glass

clean 73
copy from 29

H
heavy paper 14
Help system, control panel 12
Home screen 10
host USB port 5
HP Digital Imaging Options,

Windows 60
HP Multifunction Finisher

capacity 19
Macintosh options 66
output bins 7
replace staple cartridges 70
Windows options 61

HP paper, recommended 13,  14

I
image, paper for 15
images, Windows quality

settings 60
Information button 12
ink cartridges

door, locate 3
Macintosh status 66
replace 68
Windows status 61

Interrupt button 9
interrupt jobs 52,  53

J
jams

clear 80
prevent 81

Job Build option 33
job queue

interruption 53
multitask jobs 51
open 50
priorities 52

job status 50
job storage

Macintosh settings 63
options 47
retrieve jobs 49
store jobs 46
store jobs from a computer 47
Windows driver settings 55

K
keys

control panel 9
touchscreen 12

L
labels, load 14,  25
LEDs

locate 5
letterhead, load 25
letters, paper for 15
lights, control panel 9
load paper

jams, prevent 81
letterhead or prepunched 25
Tray 1 20
Tray 2, 3, or 4 22
Tray 5 24

locked features 11
log in 11

M
Macintosh

resize documents 64
staple options 66

Macintosh driver settings
about 62
booklets 65
both sides, print on 64
color 66
cover pages 64
custom-size paper 64
Job Storage 63
multiple pages per sheet 65
output bin, select 62
paper type, special media 25
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presets (saved settings) 63
select tray from 62
Services tab 66
shift images 66
tray, select 62
watermarks 63

manual feed tray
capacity 19
load labels, letterhead, or

prepunched 25
load paper 20
locate 3
paper sizes supported 17
paper types supported 16
select from Macintosh 62
select from Windows 54

manuals, paper for 15
map, paper for 15
margins, shift

Macintosh 66
Windows 60

master power switch
locate 4
problem-solve 77
turn device on/off 8

media
blank or preprinted, insert from

Windows 57
brands recommended 13
capacities 19
capacities, trays 3
cardstock 14
copy mixed-size originals 29
cover page, Macintosh 64
custom-size, Macintosh

settings 64
custom-size, Windows

settings 57
different, Windows settings 57
document size, selecting 56
document types 14
double-sided printing,

Macintosh 64
double-sided printing,

Windows 58
jams 80,  81
load labels, letterhead, or

prepunched 25
load Tray 1 20
load Tray 2, 3, or 4 22

load Tray 5 24
pages per sheet 59,  65
select tray from Macintosh 62
select tray from Windows 54
select tray, Macintosh 62
select tray, Windows 54
sizes supported 17
specialty 14
types supported 16

messages, control-panel 79
Multifunction Finisher

capacity 19
Macintosh options 66
output bins 7
paper sizes supported,

bins 19
replace staple cartridges 70
Windows options 61

multiple pages per sheet 59,  65
multitask jobs 51

N
n-up printing 59,  65
network address 11
network folders

Job Build option 33
multitask jobs 51
options 45
send scans to 44

newsletters, paper for 15
notes 2

O
on/off button

locate 3
problem-solve 77
turn device on/off 8

online Help system, control
panel 12

optional finishers
capacities 19
locate 6
paper sizes supported,

bins 19
select from Macintosh 62
select from Windows 54
See also HP Multifunction

Finisher
options

conflicts 12

copy, adjust 31
driver vs. control panel 54
e-mail 43
fax, adjust 34
job storage 47
Macintosh driver 62
network folders 45
save Macintosh presets 63
save Windows shortcuts 55
Windows driver 54

output bins
capacities 19
optional finishers 6
select from Macintosh 62
select from Windows 54
single, locate 5

P
pages per sheet 59,  65
paper

blank or preprinted, insert from
Windows 57

brand recommended 13
capacities 19
capacities, trays 3
cardstock 14
copy mixed-size originals 29
cover page, Macintosh 64
custom-size, Macintosh

settings 64
custom-size, Windows

settings 57
different, Windows settings 57
document size, selecting 56
document types 14
double-sided printing,

Macintosh 64
double-sided printing,

Windows 58
jams 80,  81
load labels, letterhead, or

prepunched 25
load Tray 1 20
load Tray 2, 3, or 4 22
load Tray 5 24
pages per sheet 59,  65
select tray from Macintosh 62
select tray from Windows 54
select tray, Macintosh 62
select tray, Windows 54

ENWW Index 91



sizes supported 17
specialty 14
types supported 16

paper sizes supported, bins 19
password 11
pause

Interrupt button, locate 9
jobs 50

PCI Express interface 5
phone book, fax

add names 39
edit names 40
remove names 40
send using 38
special characters 38

phone line
port, locate 5

photograph, paper for 15
photos, Windows quality

settings 60
postcard, paper for 15
power

master switch 4
on/off button, locate 3
problem-solve 77
Sleep button 9
turn device on/off 8

preprinted paper
insert pages from

Windows 57
load 25

prepunched paper, load 25
presets, Macintosh 63
print

job status 50
Macintosh driver settings 62
Macintosh features 62
multitask jobs 51
output bin, default 6
paper, recommended 15
problem-solve 77
stored jobs 49
Windows driver settings 54
Windows features 54

Print Document On 56
print quality settings

Windows 60
priorities, job 52
problem-solve

control-panel messages 79

copy or scan 77
Error button 12
jams 80,  81
power 77
print jobs 77
system administrator 76
Warning button 12

promote jobs
fax 35
prioritize 52

proposals, paper for 15

Q
quality settings, color

Windows 55
quality settings, print

Windows 60
queue

receive fax 35
queue, job

interruption 53
open 50
priorities 52

R
Ready light 9
receive faxes

cancel 36
job queue 35
multitask jobs 51

reducing documents 56
replace

ink cartridges 68
staple cartridges 70

reports, paper for 15
Reset button 9
resize documents

Macintosh 64
resizing documents 56
restaurant menu, paper for 15
retrieve stored jobs 49
RJ-11 port

locate 5

S
sales flyer, paper for 15
save settings

Macintosh 63
Windows 55

scale documents
Macintosh 64

scaling documents 56
scan, problem-solve 77
scanner interface port 5
scans, send to

e-mail 41
networks folders 44

send e-mail attachments
from Home screen 41
options 43

send faxes
cancel 36
from a computer 36
from Home screen 35
multitask jobs 51
phone book, edit 39
special characters, insert 38
to multiple recipients 37
to single recipient 36
using phone book 38

send to network folders
from Home screen 44
options 45

Services tab
Macintosh 66
Windows 61

settings
conflicts 12
copy, adjust 31
driver vs. control-panel 54
e-mail 43
fax, adjust 34
job storage 47
Macintosh driver 62
network folders 45
Reset button 9
save Macintosh presets 63
save Windows shortcuts 55
Windows driver 54

shift images
Macintosh 66
Windows 60

shortcuts, Windows 55
sign in 11
sign, paper for 15
simultaneous jobs 51
single output bin

locate 5
Sleep button 9
special characters, fax

numbers 38
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staple cartridges, replace 70
staple options

Macintosh 66
Windows 61

Start button
control panel 9
touchscreen 12

status
control panel messages 79
Home screen 10
job 50
lights 9
Macintosh services tab 66
Windows services tab 61

status LEDs
locate 5

Stop button
cancel faxes 36
locate 9

storage, job
Macintosh settings 63
options 47
retrieve jobs 49
store jobs 46
store jobs from a computer 47
Windows driver settings 55

supply-status, Services tab
Macintosh 66
Windows 61

system administrator 76

T
time 11
tips 2
touchscreen

brightness-adjustment dial 9
buttons 12
clean 73
Home screen 10
messages 79
sign in 11

training materials, paper for 15
transparencies, not supported 14
Tray 1

capacity 19
labels, load 14
load labels, letterhead, or

prepunched 25
load paper 20
locate 3

paper sizes supported 17
paper types supported 16
select from Macintosh 62
select from Windows 54

Tray 2
capacity 19
load labels, letterhead, or

prepunched 25
load paper 22
locate 3
paper sizes supported 17
paper types supported 16
select from Macintosh 62
select from Windows 54

Tray 3
capacity 19
load labels, letterhead, or

prepunched 25
load paper 22
locate 3
paper sizes supported 17
paper types supported 16
select from Macintosh 62
select from Windows 54

Tray 4
capacity 19
load labels, letterhead, or

prepunched 25
load paper 22
locate 3
paper sizes supported 17
paper types supported 16
select from Macintosh 62
select from Windows 54

Tray 5
capacity 19
load labels, letterhead, or

prepunched 25
load paper 24
locate 3
paper sizes supported 17
paper types supported 16
select from Macintosh 62
select from Windows 54

troubleshoot. See problem-solve
turn device on or off

master power switch, locate 4
on/off button, locate 3
problem-solve 77
use on/off button 8

two-sided printing
Macintosh 64
Windows 58

U
USB ports

locate 5
user name 11

W
Warning button 12
warning messages 79
warnings 2
warranty

product 86
watermarks 56,  63
Window driver settings

tray, select 54
Windows

staple options 61
Windows driver settings

about 54
blank or preprinted sheets,

insert 57
booklets 59
both sides, print on 58
chapter layout 58
color 61
color quality 55
custom-size paper 57
different paper 57
HP Digital Imaging Options 60
Job Storage 55
output bin, select 54
paper type, special media 25
select tray from 54
Services tab 61
shift images 60
shortcuts (saved settings) 55
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